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S E C T 1 O N

Introduction

The Dartcom GOES HRIT system is a high-performance, high-reliability solution for
ingesting HRIT data in real-time from the GOES series of satellites. It also provides full
display and processing facilities for the resulting images, charts and products.

The key features of the Dartcom GOES HRIT system are:

Full support for all HRIT data from GOES East and GOES West.
High-resolution digital data with no A/D conversion.

Calibrated temperature read-outs from infra-red and water vapour images
and albedo from visible images.

Easy installation, with the antenna mounted on a single post or patio mount
and one cable feed to the receiver.

Direct read-out of the HRIT data stream for interference-free images.

Data transferred from the receiver to the host PC via a USB connection to
ensure high speed and data integrity.

High-quality, high-reliability hardware and software for trouble-free, long-
term, continuous operation.

Fully automatic Windows-based XRIT Ingester data ingest and archiving
software.

Fully automatic Windows-based MacroPro post-ingest processing and
product generation software.

Powerful, easy-to-use Windows-based iDAP display and processing software.

Ideal for aviation weather information systems, storm warning systems,
forecasting, agriculture, oceanographic studies and environmental and
meteorological programmes.

A block diagram of the Dartcom GOES HRIT system is shown in figure 1.1.
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)

It is important that you read and understand sections 2, 3 and 4 of this manual
before and during installation. If the hardware and software are not installed
correctly, the system will not function properly.

At all times during installation, ensure safety regulations are followed, such as
not letting cables and connectors get wet (especially mains cables) and not
overloading ladders. Dartcom cannot accept responsibility for any injuries
caused during installation of the system.

If you have problems during installation, or are unable to make the system
function properly after installation, please contact Dartcom for technical
support. Details are given at the front of this manual.
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S E C T 1 O N

Installing the software

Introduction

The Dartcom GOES HRIT system includes software used to ingest GOES HRIT data and
provide facilities for displaying and processing it on the host PC.

This section guides you through setting up the host PC and installing the software.

Preparing to install the software

Minimum PC specifications

Before installing the software, ensure the host PC meets or exceeds the following specifica-
tions.

8-core processor.
8GB RAM (16GB recommended).
500GB SSD, plus optional 1TB SSD or RAID for archiving.

Dedicated graphics card (not on-board graphics) with display capable of at
least 1152x864 resolution.

100Mbit Ethernet.
2 available USB ports.
Windows 10 or 11 Pro or Enterprise.

English language pack and regional format.

Windows settings

Check that the Windows time zone is configured correctly for your location. Ensure also
that automatic adjustment of the PC clock for daylight saving time is switched on.



2-2 GOES HRIT SYSTEM INSTALLATION AND SETUP GUIDE

)» If you want to use UTC rather than local time, set the PC clock to UTC and the
@ time zone to “(UTC) Coordinated Universal Time”

Ensure the graphics resolution for your display is set to at least 1152x864.

Installing the software

The software which ingests GOES HRIT data and allows it to be viewed and processed is
as follows:

XRIT Ingester. This is the GOES HRIT data ingest software. It controls the
USB LRIT Receiver, performs live USB-based data ingest, archives ingested
data and outputs it in various formats.

iDAP. This is the viewing and processing software. It allows you to view,
process and print many different types of images, charts and products.

MacroPro. This is the automatic processing software. It can be set up to
perform a sequence of processing operations on an image each time it is
updated by the XRIT Ingester software. The available processing operations
include enhancement, exporting, printing, archiving, reprojection, product
creation and animation.

Follow the instructions below to install the software.

© Connect the Dartcom software security device to an available USB port on

the host PC.

If your Dartcom security device is not connected to the host PC, none of the
above programs will run.

@ If your system was supplied with a USB drive containing the Dartcom

software installers, connect that to an available USB port on the host PC (USB
3.0 ideally). Choose the Open folder to view files option, then double-click
the icon labelled Dartcom_installer.exe.

If your system was supplied with a Dartcom LRIT/HRIT System disc, insert
that into the host PC's CD/DVD drive. The Dartcom software installer
program should start automatically. If it does not, right click the Start icon,
choose Run, click Browse..., find and select Dartcom_installer.exe on the
disc, click Open, then finally OK.

© The Dartcom software installer window (figure 2.1) is displayed. Install all

the components in the list by clicking the Install all components button.



Figure 2.1

The Dartcom software
installer window

)

Summary

INSTALLING THE SOFTWARE 2-3

B Dartcom software installer X

(%

Welcome to the Dartcom software installer. Before instaling any of the software,
we recommend that you dose all other programs.

Listed below are the software components which can be installed from this disc.

To install everything, dick "Install all components™,

To install only certain items, Cirl+dick the components you want to install then didk
"Install selected components™,

Component Status "~
Adobe Acrobat Reader Installer not run
Dartcom Licence Manager Installer not run
DEM Data Installer not run
HASP Security Device Driver Installer not run
iDAP and MacroPro Installer not run v

Install all components | | Install selected components

When you have finished, dick Restart” to restart your computer {recommended)
or dick "Quit” if you want to restart later.

Restart Quit

The software is installed in the C:\Program Files (x86)\Dartcom folder by
default. You can install it to a different location if required by changing the
paths during the installation process, though this is not recommended.

O Click Restart to restart the host PC before running any of the software.

The host PC and operating system should now be set up correctly and the GOES HRIT
ingest and processing software installed but not yet configured.

The next section guides you through assembling and installing the antenna.
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S E C T 1 O N

Assembling and installing
the antenna

Introduction

The antenna manufacturer’s instructions for constructing the mounting base, assembling
the reflector, feed and support structure and installing the antenna are included in a sepa-
rate manual which you should refer to now.

» You can skip this section if you are upgrading an existing system and the
“@ antenna is already installed and the RF cable run.

)» Do not tighten the azimuth and elevation adjustment bolts fully during the
“@ installation process. The antenna needs to be aligned with the satellite
before this is done.

Running the RF cable

Once the antenna is assembled and installed, run the RF cable between the antenna and
the host PC location.

)» The cable should be securely clipped to walls and run through ducting where
@ necessary to prevent damage. Where it enters buildings, ensure you leave
generous drip loops to prevent water ingress.

Do not waterproof the external connections until the antenna has been
aligned (see section 4).
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Aligning the antenna

Introduction

Due to the narrow beamwidth of the antenna, it is critical that it is aligned towards the
satellite very accurately to ensure the best signal (and therefore the best data quality) is
obtained. This section guides you through that process.

)» You can skip this section if your antenna is already correctly aligned on your
“@ chosen satellite (GOES East or GOES West).

Calculating the antenna settings

Before commencing the antenna alignment, you need to calculate the correct azimuth, ele-
vation and feed skew for your location. You can do this using the Satellite Finder page in
the Support section of the Dartcom website (figure 4.1).

Figure 4.1

h I I. ° d WEATHER SATELLITE AND REMOTE SENSING GROUND STATIONS
The Satellite Finder on ar c@m G SaecLanguane] V]

the Dartcom website
Home News About Products Support Webcam Weather Contact

Satellite Finder

This page is intended for use with LRIT, HRIT and GVAR systems. It allows you to enter your location, choose a geostationary satelite and
obtain the required azimuth, elevation, polarisation and skew for your dish and feed.

Note: The antenna settings are intended for guidance only when aligning your dish. Some fine-tuning may be required to obtain the best
signal. Make sure there are no obstructions or sources of interference that may degrade signal quality.

Your location Geostationary satellite Antenna settings

Latitude: 50.57 °N a GOES East g at 75 oW E Azimuth: 255.1° from magnetic North

~ . Elevation: 3.5°
Longitude: 3.98 w g Find Satellite
Polarisation: Vertical

Magnetic Variation: (optional) °E u Feed Skew: 37.9°
Correct for magnetic variation

Correct for atmospheric refraction

Enter the latitude, longitude and magnetic variation (if known) at your location, choose
the required satellite (GOES East or GOES West) and click Find Satellite. The calculated
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azimuth, elevation, polarisation and feed skew are displayed on the right-hand side of the
page. Make a note of them for later.

Aligning the antenna

The USB LRIT Receiver contains a dedicated alignment receiver which simplifies the
process of aligning the antenna towards the satellite. The receiver needs to be taken to the
antenna location and connected to the LNB output. It does not need to be connected to
the host PC yet.

Using the USB LRIT Receiver at the antenna location requires a mains

A extension lead to be run outside temporarily. This should be connected via
an RCD and the alignment procedure carried out in dry conditions only to
minimise the risk of electrocution.

The antenna alignment procedure is as follows:

o
(3]

Using a compass and inclinometer, adjust the azimuth and elevation of the
antenna to approximately the angles calculated earlier. Information on
adjusting the antenna azimuth and elevation is given in the manufacturer’s
instructions for the antenna system.

Set the feed polarisation to vertical.

Using the supplied 3m RG58 adaptor cable, connect the LNB output to the
LNB socket on the back panel of the USB LRIT Receiver.

Ensure your LNB will accept +15V from the receiver to power it via the co-axial
cable. If not, you will need to use an external Bias “T” to power the LNB.

o

® © © ®

=]

Connect the DC jack from the receiver power supply unit to the POWER
socket on the back of the receiver. Connect the IEC plug of the mains lead to
the IEC socket on the power supply unit. Connect the other end to your
mains extension lead, then switch on the mains supply.

The receiver has an LED bar display on the front panel which shows the
signal level. On the back panel is a 10-turn preset control labelled INPUT
ATTENUATION. Using the supplied trimming tool, adjust the preset so the
display reads about half scale. Turning the preset clockwise increases the
attenuation, which reduces the display reading, and vice versa.

Adjust the azimuth of the antenna slowly and carefully until the maximum
reading is obtained on the signal display. If the display reaches full scale,
turn the INPUT ATTENUATION preset clockwise until the signal level display
reads half scale again and continue adjusting the azimuth.

Tighten the azimuth adjustment bolts to lock the azimuth.
Adjust the elevation of the antenna as you did the azimuth in step 0.
Tighten the elevation adjustment bolts to the lock the elevation.

There will inevitably be some interaction between the azimuth and elevation
adjustment, so repeat steps @-0 (loosening each axis’s adjustment bolts in
turn) until the maximum signal reading is obtained.

Make a note of the current signal display reading (18 LEDs, for example).

If the feed cannot be reached safely from the ground, position a suitable
stepladder in front of the antenna.
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® Using a marker pen, mark the feed’s current position by drawing a line from
the mounting head plate to the rim of the feed.

=]

Adjust the feed skew to approximately the angle calculated earlier.

®

Remove the stepladder from in front of the dish and check the signal display
reading on the receiver.

® Fine-tune the feed skew until the maximum signal reading is obtained,
remembering to increase the attenuation if the display reaches full scale.
This process can take some time, but is important because the antenna gain
needs to be maximised to obtain the best signal.

@ Tighten the three Allen screws on the feed mount to lock the skew angle.

Completing antenna installation

Summary

A

When the optimum antenna alignment has been found and image quality testing has
been completed, wrap all cable connections with the supplied self-amalgamating tape to
ensure they are waterproof.

It is important to waterproof all the cable connections well to prevent damage
by ingress of water.

The antenna should now be installed and aligned on the satellite, and the RF cable run
between the antenna and the host PC location.

The next section guides you through installing and operating the USB LRIT Receiver.
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Installing the receiver

Introduction

The Dartcom USB LRIT Receiver turns the RF signal from the antenna into a digital data
stream which is sent to the host PC for decoding and processing.

This section guides you through installing the receiver in its operational location.

Installing the receiver

Follow the instructions below to install the USB LRIT Receiver.

© Choose a suitable location for the receiver. It is cooled by convection and
should therefore be placed out of direct sunlight with sufficient space
around it to allow free air circulation.

Do not place books, magazines or other objects around or on top of the
receiver as this could hinder the unit’s cooling and cause it to overheat.

® Connect the cable from your LNB to the LNB socket on the back panel of the
receiver.

» Ensure your LNB will accept +15V from the receiver to power it via the co-axial
) . M u=xn
cable. If not, you will need to use an external Bias “T"” to power the LNB.

©® Connect the DC jack from the receiver power supply unit to the POWER
socket on the back of the receiver. Connect the IEC plug of the mains lead to
the IEC socket on the power supply unit. Connect the other end to a nearby
mains power outlet, then switch on the mains supply.

O Connect the USB cable from the USB socket on the back panel of the receiver
to an available USB port on the host PC.
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» It is best to allocate a particular USB port to the receiver because its control
) . . . .
(COM) port number will change if you connect it to a different port.

©® The Windows hardware setup assistant may appear. If so, allow it to select
the correct drivers automatically, and if warnings about driver signing are
displayed, ignore the warnings and allow them to be installed.

O If the receiver and driver software are working correctly, an icon should
appear in the system tray (next to the clock). Double-click it to display a list
of the connected devices, which should include USB LRIT Receiver.

@ Using the supplied trimming tool, adjust the INPUT ATTENUATION preset
control on the back panel of the receiver until all but two or three of the
green LEDs are illuminated. Turning the preset clockwise increases the
attenuation, which reduces the display reading, and vice versa.

The LED indicators on the front panel of the receiver should now be as shown in table 5.1,
in which case it is ready to receive live data.

- Table 5.1 1, dijcator State
Reszz;(\?;roLgDein%Si’EalEglrI LNB POWER llluminated
after installation ~SIGNAL LOCK Iluminated
SIGNAL LEVEL All green LEDs illuminated except two or three
USB READY [lluminated
SERIAL RX/TX Not illuminated
BUFFER E llluminated

FRAME SYNC DETECTION Not illuminated

Specifications
The specifications of the Dartcom USB LRIT Receiver are shown in table 5.2.
Table5.2 pp
USB LRIT'Rece_iver Input frequency 135MHz to 144MHz
specifications

Input level range -90dBm to -20dBm preset by adjustable
50dB attenuator

Image rejection >60dB

Input impedance 50Q

Signal strength display 20 LED real-time colour bar display with 1dB
step per LED (approx)

DSP demodulator

Type Digital Costas Loop

Modes BPSK, QPSK

Baseband filters Root raised cosine, roll-off factor 0.4

Typical Eb/No performance 6.4dB for 10° bit errors using Viterbi rate of
'/> before R-S decoding
(continued...)
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(continued...)

Data
Encodings NRZ-L, NRZ-S,NRZ-M
Symbol rates 64ksps to 1024ksps
Convolution decoding Viterbi, rate '/, K=7,G1=171,G2=133
Descrambling modes V.35 CCITT, IESS 308/309, none
Electrical/mechanical
Supply voltage 15V DC @ 2A supplied by external mains
power supply unit (PSU)
External mains PSU Input: 100-240V AC 47-63Hz @ 1.2A max
Output: 15V DC @ 3.4A
Downconverter power 14-15V DC @ 0.75A protected by thermal
output fuse
Power connector Standard 2.1Tmm DC jack, centre pin +ve
RF input connector 50Q BNC female
Size (LxWxH) 240x175x60mm (including connectors)
Weight 1.7kg (including PSU)
Operating temperature 0°C to 35°C non-condensing
EMC CE certification EN55022 class A digital device
Interface
Host PC USB 1.1, type B connector
Receiver control RS-232,9600bps via USB

The layouts of the front and back panels of the USB LRIT Receiver are shown in figures
5.1 and 5.2 respectively.

Summary

The receiver should now be installed in its operational location and ready to use. You
should also be familiar with its various controls and indicators.

The next section guides you through configuring the software according to your require-
ments.
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Indicate activity on receiver
control serial port
RX = receiving data
TX = transmitting data

USB LRIT Receiver

LNB  SIGNAL
POWER LOCK

SIGNAL LEVEL

Indicates LNB power state:
[lluminated = on
Not illuminated = off or short circuit

Indicates signal lock state:
[lluminated = locked
Flashing = searching for signal

Not illuminated = not locked
(LNB must be connected
to avoid false locking)

Figure 5.1 - Layout of the front panel of the USB LRIT Receiver

Indicate data buffer usage
E=empty
/2= half-full
F =full

Changes each time a frame synchronisation
pattern is detected in the data stream
during live ingest — if it changes erratically
or stops, the signal is poor or non-existent

FRAME|SYNC

Indicates relative signal level - Indicates XRIT Ingester
adjust INPUT ATTENUATION preset software has opened

control on back panel if reading

is zero or full scale

USB connection to receiver
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S E C T 1 O N

Configuring the software

Introduction

You should already have installed the software in section 2. This section guides you
through initial configuration.

)» Before you start, ensure your Dartcom security device is connected to the host
PC otherwise the software will not run.

iDAP

Follow the instructions below to configure the iDAP software.
@ Start the iDAP software from the Windows Start menu.

@ Select Utilities»Configuration.... The Configuration window (figure 6.1) is
displayed with the Station tab selected. In the Details area, enter a name
and description for your ground station in the Name and Description boxes
respectively. In the Position area, switch off Update automatically, set
Source to Fixed and enter the latitude and longitude of your station position
in the Latitude and Longitude boxes respectively.
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Figure 6.1

The Configuration
window Of the Station  Appearance Paths = Session

Cenfiguration ? X

iDAP software Details Processing
Name: | Dartcom | [ Limit worker threads to:
P &
Description: | Dartcom ground station I: =

Available CPU cores: 16

If not limited, half the

Logo: | Choose... | Resst available cores (up to a
maximum of &) will be used.

Position
Update automatically
Source: (@) File: | C:\Users\Chris\Wright\AppData \Roaming\Dartcom\CommanyGNSS. txt Choose... | | Reset

(OFixed  Latibude; | 50.578 “M Longitude: | 3.939 iy

Document updating Display formats
Interval: | 10 | seconds Position: ddd.ddd® ~

d=degrees, m=minutes of arc,

[Irlay a sound when documents are updated c=seconds of arc

Choose... | | Reset | B+ Time: Local time when ingested

Leave blank to use the default Windows alert sound,
File names: | Local time when ingested

Temperature: | °C

Cancel

©® Click the Paths tab (figure 6.2) and ensure the paths are configured correctly.
The default settings are shown in table 6.1, or you may wish to set them to
other folders if you have particular data storage requirements.

Figure 6.2 Configuration ? x
The iDAP Configuration
WindOW Wlth the Station Appearance Paths  Session
Paths tab diSplayed DAP documents: | C:\Dartcom\Images | Choose... | | Reset
Exported data: | C:\Dartcom\Images | Choose... | | Reset
Map overlays: | C:\Program Files (x&6)\DartcomMap overlays | Choose... | | Reset
Temporary storage: | C:\Users\CHRISW ~1\AppDatalLocal {TempDar tcom iDAP | Choose... | | Reset
HRPT archive: C:\Dartcom\Data\HRPT\Archive Choose...  Reset
AHRPT archive: C:\Dartcom\Data\AHRPT\Archive Choose... | Reset
DMSP archive: C:\DartcomData\DMSP\Archive Choose... | | Reset
XRIT archive: C:\Darteom\Pata WRITArchive Choose... | | Reset
GeoTIFF archive: C:\Dartcom\Data\GeoTIFF Choose... | | Reset

Cancel
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Table 6.1 pa¢p Default folder
Paths to configure in

the iDAP software iDAP documents C\Dartcom\Images

Exported data C:\Dartcom\lmages

Map overlays C:\Program Files (x86)\Dartcom\Map overlays
Temporary storage (user’s temporary folder)\Dartcom iDAP

XRIT archive C:\Dartcom\Data\XRIT\Archive

O Click OK to apply the new configuration.

© Ensure Utilities»Automatic update is switched on. This causes open
documents to be updated with new data automatically.

O Ensure Utilities»Start MacroPro automatically is switched on. This causes
MacroPro to be started automatically each time you open iDAP.

MacroPro

Follow the instructions below to configure the MacroPro software.
© Start MacroPro by selecting Utilities»Start MacroPro... within iDAP.

® By default, MacroPro is configured to minimise itself after opening. Click its
icon in the Windows taskbar to restore its window.

© Choose Utilities»Configuration.... The Configuration window (very similar
to figure 6.1) is displayed. Click Synchronise with iDAP (in the bottom left
corner) and click OK.

XRIT Ingester

Follow the instructions below to configure the XRIT Ingester software.
@ Start XRIT Ingester software from the Windows Start menu.
® Click the GOES HRIT tab (figure 6.3).

Figure 6.3 @ cossrrr

The GOES HRIT tab  cor e e S R _
Of th e X R IT In g ester Start Stop Pause Resume Mot ingesting N:iizn:;g Q Nl:t‘:::ﬁ::g on Q N::r:f_m?:;n ecompression
SOftW are [startingesting automtically APID Packets File type Count Result Count
Reception  File acquisiton  Decryption & decompression  Qutput
Ingest data
Receiver: USB LRIT Receiver - 5N model ~

Control port: v output

= Not
Frequency: 1654.1000 12| w2 Calibration... ot running

Latest data:

Downconverter: | Quorum 1591-137, 5MHz ~

Data source: Dartcom LUSB LRIT interface v

Source device: ~

Apply settings
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©® In the Control area, switch on Start ingesting automatically.

O In the Reception tab (figure 6.4), ensure USB LRIT Receiver - SYN model is
selected in the Receiver drop-list. Select USB LRIT Receiver in the Control
port drop-list. Ensure Frequency is set to 1694.1000. Select the type of
downconverter connected to your receiver in the Downconverter drop-list.
Ensure Dartcom USB LRIT interface is selected in the Data source drop-list.
Select USB LRIT Interface in the Source device drop-list.

F|gure 6-4 Reception  File acquisiton  Decryption & decompression  Output

The XRIT Ingester  [Amgest data

Receptlon tab Receiver: USE LRIT Receiver - SYN model ~

Control port: USE LRIT Receiver (COM3) w

Frequency: 1694,1000 == MHz Calibration...

Downconverter: | Quorum 1691-137.5MHz ~
Diata source: Dartcom USE LRIT interface hd
Source device! | USB LRIT interface ~

O In the File acquisition tab (figure 6.5) ensure Acquire files is switched on,
and Archive acquired files and Process only these file types are switched
off for now.

Flgure 6.5 Reception File acquisiion  Decryption & decompression  Qutput

The XRIT Ingester File & acquire fies

acquisition tab
[JLook for files in:

C:\Dartcom\DataWRIT\Acquired Choose...
[] archive acquired files in:
Ci\Dartcom\DataWRITRaw Choose...

Delete files over | 1 =

-

[Jrrocess orly these file types:

Process new file types by default Clear file types
Alarm if maximum time without data exceeded
0 In the Decryption & decompression tab (figure 6.6) ensure Decrypt and

decompress files is switched on, and Before decompression, archive files,
Archive processed files and Extract data from files are switched off.
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Figure 6.6 Reception File acquisition ~ Decryption & decompression  Qutput
The XRIT IngeSter [ Decrypt and decompress files

Decryption settings...

Decryption &
deCOmPressmn tab [Before decompression, archive files in:
C:\Dartcom\Data XRIT\Compressed Choose...
Delete files over | 1 =
[ archive processed files
Alpha-numeric text Use for all
Archive in:
C:\Dartcom\Data WRIT Archive Choose...

By type By date By time

Delete files over | 1 =

-

[CJExtract data from files and archive in:
C:\Dartcom\Data XRIT \Extracted Choose...

Delete files over | 1 =

@ In the Output tab (figure 6.7) ensure Map overlays path is set to C:\
Program Files (x86)\Dartcom\Map overlays and Store previews in
archives is switched on.

Figure 6.7 Reception File acquisiion Decryption & decompression  Output
The XRIT |ngeSteI’ Map overlays path:
output tab | C:\Program Files (x86)\Dartcom\Map overlays Choose...

[~]5tore previews in archives
Output data:
- Image data ~

=i

Settings... Add... |  Edit... Duplicate... Delete...

O Switch on Output data. In the list below it, under Image data right-click
iDAP image and select Settings.... The iDAP image settings window
(figure 6.8) is displayed. In the Save area, ensure Path is set to C:\Dartcom\
Images (or your chosen iDAP images folder). If you want to create an archive
of iDAP images by default, switch on Archive, ensure Path is set to C:\
Dartcom\Images\Archive (or your chosen iDAP images archive folder) and
set the number of days you want to keep in the archive.
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Figure 6.8

The XRIT Ingester iDAP
image settings window

iDAP image settings ? X

Defaults

Changes will affect new iDAP image outputs and existing outputs configured to use the
default settings.

Save

Path: | C:\DartcomiImages | Choose...

Archive
Path: | C:\DartcomImagesArchive | Choose...

Delete files over | 3 | days old

Map overlays. ..

Cancel

O Click Map overlays... to display the Default overlay settings window
(figure 6.9). nsure that Create overlays is switched on, then configure the
grid lines and overlays as required. The factory defaults are suitable for most
purposes, but you may wish to add state boundaries for individual countries,
or alter the colours or line styles. Full reference information for this window
is provided in the Dartcom XRIT Ingester software user guide.

)» These overlay settings will be used as the defaults, but they can be customised
“@ for individual outputs if required.

Figure 6.9

The XRIT Ingester
Default overlay

Default overlay settings ? X

Create overlays

. ind Grid lines
Settlngs window Spacing: Colour:  Style: Width:

Major  |10.0° —s5olid ~| |—Thin

[IMinar 2.5% - == Dash — Thin

Overlays
v Mo,  Overlay Calour  Style Width
1 GSHHG barders, L1 {national) ~ =—Solid ~ || — Thin ~
2 | GSHHG shorelines, L2 {lakes) ~ —Solid v ||—Thin
3 GSHHIS shorelines, L1 (coastines) ~ =— Sglid || — Thin ~
4 | GSHHG shorelines, L3 (lake islands) ~ —5Solid ~||—Thin =~
5 GSHHG shorelines, L6 (Antarctic grounding ling) —Solid || — Thin w
Add overlay Delete overlay... To top Up Down | Tobottom

Reset to factory defaults. .. Cancel

@ Click OK when you have finished configuring the default overlay settings,
then OK again to close the iDAP image settings window.

® At the bottom of the GOES HRIT tab, click Apply settings to make your
changes take effect.



Table 6.2

States of the USB LRIT
Receiver LED indicators
during live ingest

Figure 6.10

The XRIT Ingester
Reception status
window

Table 6.3

Status information for
the USB LRIT Receiver
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@ In the Control area, click Start to commence live ingest. The receiver will be
programmed (notice the RX and TX LEDs flashing) and after a few seconds
the LED indicators on the front panel of the receiver should be as shown in

table 6.2.
Indicator State
LNB POWER [lluminated
SIGNAL LOCK Illuminated
SIGNAL LEVEL All green LEDs illuminated except two or three
USB READY [lluminated
SERIAL RX/TX Flashing very occasionally, otherwise not illuminated
BUFFER '/2flashing regularly

FRAME SYNC DETECTION Pattern changing smoothly and regularly

® The GOES HRIT tab icon should now be green (&) and spinning to indicate
that live ingest is in progress. The icon at the top of the Reception area
within the Status area should also be green (&) indicating that frame
synchronisation has been achieved.

@ In the Reception area within the Status area, click the & (detailed reception
status) button to display the Reception status window (figure 6.10). This
shows details of the data being ingested and the status of the receiver. Click
Update to obtain the current receiver status, described in table 6.3.

Reception status

E Bytes received: 1801560064

Frames received: Invalid frames:

Frames processed: Error frames:

Fill frames: Uncorrectable:
VCID Frames Sequence errors Packets
1] 27 1] g o]
1 50571 1] 207207 4
2 37269 0 92450 o]
7 158494 0 92430 3
3 35952 1] 92480 o]
9 95003 1 92478 7
13 147735 0 92430 [
14 149496 1] 92480 [
15 1456258 0 92450 [
17 25797 0 24552 2
20 11887 1] 5732 3
21 53144 0 5768 o]
22 153045 0 4230 3
24 2083 1] 233 o]
Item Normal value
Receiver USB LRIT Receiver — SYN

model

Mode GOES HRIT
Downconverter (depends on selection)
Downconverter offset  1553.5MHz
Data rate 463500bps

(continued...)

Flywheeled frames: I:I Packets received: 1122432

Packeterrors ™ | Receiver status:

Packets processed: 1122432

Update Copy

Receiver: USB LRIT Receiver - 5YM model
Mode: GOES HRIT

Downconverter offset: 1553, 500MHz
Frequency: (unavailable)

Data rate: 463500bps

Symbol rate: 927000bps

Error correction: Non-DVB, 1/2 Viterbi
Demodulator mode: BPSK

Data polarity/format: Serial output
Fade time: 10s

Tune step: 411kHz

LME frequency tolerance: £0kHz

LME power: On

Current error rate: <1:10e12
Current AGC level: 79

COperational AGC level range: 5 to 120

Current signalfmoise: =16.0d8
Cimmalimnira Fault Hirachalds 4 (AR

>

Description

Dartcom USB LRIT Receiver,
synthesised (tuneable) model
Self-explanatory
Self-explanatory
Downconverter LO frequency
Data rate after Viterbi decoding
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(continued...)
Symbol rate 927000bps

Error correction Non-DVB, 1/2 Viterbi
Demodulator mode BPSK
Data polarity/format Serial output

Fade time 10s

Tune step 411kHz

LNB frequency +0kHz

tolerance

LNB power On

Current error rate Between 1:10and 1:10°

Current AGC level Between 0 and 255

Operational AGC 5to 120

level range

Current signal/noise Between 3.7dB and 16dB
Signal/noise fault 4.0dB

threshold

Logged signal/noise Between 3.7dB and 16dB
minimum

Logged signal/noise Between 3.7dB and 16dB

maximum

Tune status Locked, fast sweep speed
Tune offset OkHz

Clock (current local time)
Faults (list of logged faults)

Channel symbol rate before
Viterbi decoding

Forward error correction mode
Self-explanatory

Receiver output mode

Time to wait after loss of signal
lock before searching again
Demodulator frequency step
used in signal search

LNB frequency stability
tolerance

Self-explanatory

Error rate after Viterbi decoding
Digital AGC level - the lower it
is, the weaker the signal
Normal AGC level range - levels
outside this are logged as faults
Current signal/noise ratio
Minimum signal/noise, below
which a fault is logged
Minimum signal/noise logged
since midnight (local time) —
reset each day at midnight”
Maximum signal/noise logged
since midnight (local time) —
reset each day at midnight”
Demodulator lock status and
signal acquire mode
Difference between requested
frequency and that locked on
to by demodulator

Receiver’s internal clock -
synchronised to host PC’s
clock automatically each day at
midnight

List of faults logged by receiver
since midnight - cleared each
day at midnight?

* When the software is first started, this figure may not be valid because the demodulator takes time
to settle down. A more realistic figure will be available when the logged limits are reset at midnight.

1 When the receiver is programmed, one or more signal fade faults may be generated. This is quite

normal and they will be cleared automatically at midnight.
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® Leave the system ingesting data for at least an hour to ensure all available
products have been ingested. As new products are received they will appear
in the Latest data list on the left-hand side of the Output area within the
Status area. Click a product name in the list to view information about it and
a preview (if available).

The antenna, receiver, host PC and software should now be installed, set up and ready to
use.

The next section provides a number of tutorials and tips to help you get started using the
software. You should also refer to the separate XRIT Ingester software user guide and
iDAP/MacroPro software user guide for further information.
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S E C T 1 O N

Using the software

You should already have installed the software in section 2 and configured it in section 6.
This section describes each program, then shows how to accomplish common tasks and
use the core software functions via tutorials and useful tips.

About the software

The Dartcom GOES HRIT software comprises the following programs:

XRIT Ingester ingests GOES HRIT data and should be left running all the
time. It allows all or part of each product to be output as a Dartcom iDAP
image, or other formats for use in third-party image processing software.
You will need to set up the outputs to meet your requirements for the
geographical area of coverage and range of products. If required, XRIT
Ingester can also maintain archives of products that have been output.
However, it does not create iDAP animations, which is one of the tasks
performed by MacroPro.

MacroPro is an automatic image processing program and should be left
running all the time. It is effectively an automated version of iDAP and can
be set up to perform a list of operations (a macro) on each image output by
XRIT Ingester every time it is updated with the latest data. The processing
operations include enhancement, masking, exporting, printing, animation,
reprojection and creation of products. MacroPro will not do anything unless
you set up macros for the images you want to process.

iDAP (integrated display and processing) allows you to view, process, print
and export images output by XRIT Ingester and processed by MacroPro. You
can also play back and edit animations created by MacroPro.
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Tutorials

Figure 7.1

The iDAP image output
settings window ready
to add an output

M

Below are several tutorials designed to show you how to use the core software functions
and see some initial results. They are intended to be performed in sequence and therefore
follow on from each other.

Having completed the tutorials, we recommend you explore the software further, referring
to the separate XRIT Ingester software user guide and iDAP/MacroPro software user guide.

Tutorial 1: Setting up an iDAP image output

To be able to view ingested GOES HRIT images in iDAP you need to set up outputs in
XRIT Ingester. This tutorial will show how to set up a single plane iDAP image output for
an area of the GOES HRIT IR13 FD product which covers the USA.

O Ifitis not already running, start XRIT Ingester from the Windows Start menu.
@ C(lick the GOES HRIT tab, then click the Output tab.
©® Ensure Output data, Image data and iDAP image are switched on.

O Under Image data right-click iDAP image and select Add output.... The
iDAP image output settings window (figure 7.1) is displayed.

iDAP image output settings ? x

Name: ‘ ‘

e | <] ostatype: | -]

Planes Area

() Single plane {greyscale) (®) Whole image
@ Multi-plane (false colour) Selected area:
Master Product Oversample

o |
e |
S [—
Sub-sample by factor
' 1:1.0
11 L3z
Map overlays:
Enhancement: (®) Default
Min-max v Ocustom | Edi...

ve
Path: (@) Use default: C:\Dartcom\Images

(| c:\partcom\images Choose...
File name: (@) Build automatically:
Channel [“]Data type [Jpate and time

[service [FlPraducts
() Use putput name

@]
Archive

(®) Use default settings
() Use custom settings:

C:\partcom\Images\Archive Choose....

Delete files over | 3

Cencel

O In this tutorial we will be setting up an output for the 10.3um infra-red band
(channel 13) which covers the USA, so enter USA IR13 in the Name box.

0 In the Service drop-list select GOES-16 if you receive GOES East, or GOES-18
if you receive GOES West.

@ In the Data type drop-list select GOES-16 product or GOES-18 product as
appropriate.

If the above items are not listed, click Cancel, leave the system ingesting data
for around half an hour, then continue this tutorial.



Figure 7.2

The IR13 FD product
selected and its
preview displayed

Figure 7.3

An area selection box
drawn around the USA
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O In the Planes area select Single plane (greyscale).

© In the Product drop-list select IR13 FD. A preview is displayed on the right-
hand side as shown in figure 7.2.

iDAP image output settings 7 *

Rer |USA IR13 |

Service: | GOES-16 | Data type: | GOES-16 product ~]
Planes Area
(®) single plane (greyscale) @) Whole image
() Multi-plane (false colour) () Selected area:

Master Product

olEE_—— o

0 o Apply
Sub-sample by factor
' Li0 TR
L1 1:32
Width: | 5424 Height: | 5424

B ETI

Enhancement: (@ Default
Min-max v Ocustom | Edi..
Save

Path: (®) Use default: C:\Dartcom\Images
(O | C:\Partcom\Images Choose...
File name: (@) Build automatically:
Channel Data type
[service Products
(C)Use output name

O

[pate and time

[ archive
(@) Use default settings
(O Use custom settings:

C:\Dartcom\Images\Archive Choose...
Fit preview to view Show overlay Latitude: 35.93°N, Longitude: D88.65°W

Delete files over | 3

Cancel

@ In the Area area, click Selected area, then draw a rectangular box on the
preview which covers the USA, as shown in figure 7.3.

iDAP image output settings ? *

Fer= |USA IR13 |

Service: | GOES-16 | Data type: | GOES-16 product |
Planes Area
(®) 5ingle plane (greyscale) () Whole image
(O Multi-plane (false colour) (@) selected area:
Master Product Left:  Top:

0| Ce—

width: Height:

Sub-sample by factor

[} 1o [«
11 1:32
width: (2258 | Hegnt: | 1213

(2= | (25 ] o cvers:
Enhancement: (@ Default
Min-max ~|  Ocustom | Edit. .
Save

Path: (@ Use default: C:\Dartcom\Images
(| C:\Dartcom\Images Choose...
File name: (@) Build automatically:
Channel Data type
[ service Products
(C)Use output name

O

[1pate and time

[ archive
(®) Use default settings
(O Use custom settings:

C:\Dartcom\Images\Archive Choose...

Fit preview to view

Show overlay Latitude: 35.93°N, Longitude: 088.65%W/

==

Delete files over | 3

@ In the Sub-sample area, ensure by factor is selected in the drop-list and the
slider is set to 1:1. This will produce a full-resolution image.
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@ Ensure Min-max is selected in the Enhancement drop-list.

® Set Map overlays to Custom and click Edit... to display the Overlay
settings window (figure 7.4).

Figure 7.4

Ovwerlay settings ? X
The Overlay settings
window with the Ecreste overtays
Grid lines
default overlays Spacing:  Colour: _ Style: width:
MMaior 10,00 v —5olid v |—Thin
CMinor 2,52 1 --Dash — Thin
Qverlays
¥ No. Overlay Colour  Style Wwidth
1 GSHHG borders, L1 {national) ~ — Solid ~ || — Thin v
2 GSHHGE shorelines, L2 (lakes) ~ = Solid | | — Thin ~
3 GSHHG shorelines, L1 {coastlines) ~ = Solid || — Thin ~
4 |GSHHG shorelines, L3 (ake islands) ~ —Solid v ||—Thin
5 | GSHHG shorelines, L6 (Antarctic grounding line) —35did ~ | |—Thin
Add overlay Delete overlay. .. To top Up Down | Tobottom
Reset to factory defaults... Reset to defaults, .. Cancel
@ Click Add overlay. A new overlay will be added at the top of the Overlays
list. In the drop-list in the Overlay column, select GSHHG borders, L2
(Americas states). Use the picker in the Colour column to set the overlay’s
colour to magenta. The window should now resemble figure 7.5.
Figure 7.5 Overlay settings ? %
The GSHHG borders, L2
(Americas states) =~ dCest=owar
Grid lines
Overlay added Spadng: Colour:  Style: Width:
EMajor 10,00 —solid v |—Thin
[OMinor 2,52 1 == Dash — Thin
Overlays
v Mo,  Overlay Colour Style Width
BN GSHHG borders, L2 (Americas states) I ~ | —sold vI—Thin v
2 | GSHHG borders, L1 {national) ~ —5Solid ~||—Thin =~
3 GSHHG shorelines, L2 (lakes) ~ —Solid ~||—Thin =~
4 GSHHG shorelines, L1 {coastlines) ~ — Solid || — Thin ~
5 GSHHG shorelines, L3 {lake islands) ~ — Solid v~ || — Thin v
[ GSHHG shorelines, L6 (Antarctic grounding ling) = Solid | | — Thin ~
Add averlay | | Delete overlay... To top Up Down | | To bottom
Reset to factory defaults... Reset to defaults. .. Cancel

® Click OK to close the Overlay settings window.



Figure 7.6

The USA IR13 output
fully set up

Figure 7.7

The Output tab with the
USA IR13 iDAP image
output added
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@ In the Save area of the iDAP image output settings window, ensure Path is
set to Use default, then set File name to Use output name.

@ Ensure Archive is switched off. The window should now resemble figure 7.6.

iDAP image output settings 7 *

Rer |USA IR13

Service: | GOES-16 | Data type: | GOES-16 product

Planes Area

(®) single plane (greyscale) (O Whole image
() Multi-plane (false colour) (®) Selected area:
Master Product Left:  Top:

0| Cerem—

Width:  Height:

Sub-sample by factor

' Li0 TR
L1 1:32
Width: m Height: | 1213

(2 oo |
Enhancement: (O Default
Min-max ~v| (@custom | Edit...

Save
Path: (®) Use default: C:\Dartcom\Images

(O | C:\Partcom\Images Choose...

File name: () Build automatically:

Channel Data type Date and time
Service Products
(®) Use output name
O
[Carchive

Use default settings
Use custom settings:

C:\Dartcom\Images\Archive Choose...

Fit preview to view

Show overlay Latitude: 35.93°N, Longitude: 088.65°W

= Concel

Delete files over | 3

® Click OK to add the output. The Output tab should now resemble figure 7.7,
with a new output named USA IR13 listed beneath Image datariDAP
image. Its settings are shown in the box below the Output data box.

Reception  File acquisiion Decryption & decompression Output

Map overlays path:

| C:\Program Files (x86)\DartcomMap overlays Choose. ..

Store previews in archives

Qutput data:

=-[]Image data -~
B ]iDAP image

[FliDaP chart

PCI Geomatica

[IERDAS IMAGINE

ENVI/IDL

GeoTIFF

PGM file

Raw file

- alpha-numeric text W

Service: GOES-16 -
Data type: GOES-16 product

Product: IR13 FD

Area: 2258x1213 sub-sampled by 1:1.0

Enhancement: Min-max

Overlays: Custom

Path: (default) w

Settings... Add... | | Edit... Duplicate... Delete...

® Click Apply settings (below the Output tab).
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Figure 7.8

The Open window
with the USA IR13
image selected
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@ In the Latest data list within the Output area in the Status area, select
GOES-16/18rImage data»GOES-16/18 productrlR13 FD as appropriate.
Its preview will be displayed on the right-hand side. Wait until all of its
segments have been received, then move on to the next tutorial which will
show you how to view the resulting image in iDAP.

If all segments had already been received when you clicked Apply settings,
you will need to wait for the next transmission of the IR13 FD product before
moving on. This is because outputs are produced immediately after the last
segment of their corresponding product (or products) has been received.

Tutorial 2: Opening an iDAP image

This tutorial will show you how to open and view the iDAP image that was created by the
XRIT Ingester output you added in the previous tutorial.

O Ifitis not already running, start iDAP from the Windows Start menu.

@ In the View menu, ensure Palette key, Station position, Points features,
Track features, Range rings, Overlays, Lat/lon legends, Tool bar, Read-
outs panel and Status bar are switched on.

©® Select FilerOpen.... The Open window (figure 7.8) is displayed. In the Files
of type drop-list, ensure All iDAP documents is selected. Select the USA
IR13 image (% icon) and click Open.

3 Open X

v @ =@
~ i File details

Date modified Type Date:  Thu, May 18, 2023
Time:  17:30:20 (UTC+1:00)

Look in: |

*

Images

Mame

Sample 22/05/2023 0%:54  File folder 5 e
i ze: X
Quickaccess 1 )55 |R13.did 22/05/202312:04  iDAP image Storage: 5.8 MB
Satellite: GOES-16
- Format: HRIT image
Type: Infra-ed
Desktop
Data:  Channel 13 (10.30pum)
m
Libraries Preview:
This PC
Metwork
< >
File name: USA IR13.did ~
Files of type: AllIDAP documerts (*did, *.dmd) - Cancel

O The USA IR13 image is opened in a new iDAP image window (figure 7.9).
You can move the mouse over the image to see read-outs in the panel on the
right-hand side of your screen. There are many processing facilities to
explore, but for now move on to the next tutorial which will show you how to
create an animation.



Figure 7.9

The USAIR13
iDAP image

Figure 7.10

The Automatic
processing settings
window
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Tutorial 3: Creating an animation

This tutorial will show how to automatically animate the iDAP image output set up in
tutorial 1. It will also show how to add a Blue Marble mask to a single-plane (greyscale)
image to give it some colour.

O If MacroPro is not already running, start it by selecting Utilities»Start
MacroPro... within iDAP.

® By default, MacroPro minimises itself after opening because it normally runs
in the background with no user input required. Click its icon in the Windows
task bar to restore it.

©® Select Utilities»rAutomatic processing settings.... The Automatic
processing settings window (figure 7.10) is displayed. This allows you to set
up macros which perform processing automatically when new images are
output by XRIT Ingester.

Automatic processing settings ? X

Current macro set:
[ efauit ~| & &

(no item selected)

Add macra.., | | Add RGB product | | add foder | | [Duslicate | |Rename | | Dckeie..

Cut Capy Paste To top Up Down To bottom

Destination: = Above | Below | Firstin folder | Lastin folder Cancel
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O Macros can be organised into folders to make them easier to find and
manage. Click Add folder and name it USA. The window should now
resemble figure 7.11.

Figure 7.1 1 Automatic processing settings ? x
The USA folder added lchfat WS
Default - o
to the macro set
Addmacro... || AddRGBproduct | Addfolder | | Duplicate | | Rename | | Delete...
Cut Copy Paste To top Up Down To battom
Destination: | Above || Below || Firstin folder Cancel

selecting an existing item and using the Destination selector at the bottom of
the window, or right-clicking an existing item to display a menu with options
for adding a new item inside, above or below it. This tutorial will use the
right-click approach.

ﬁ» When adding folders or macros, you can choose its position by either

© Right-click the USA folder and select Add macrorLast in folder.... The
Image to process window (figure 7.12) is displayed. Select USA IR13 and
click Choose.

Flgure 7.12 £3) Image to process X
The Image to Lok in: | Images v| (€] ¥ o M-
process window - - File detais
% Mame Date modified Type Date:  Thu, May 18, 2023
Sample 22/05/202309:54  Filefolder Time:  17:30:20 (UTC+1:00)
Cuick access [ & . i R Size: 2257 x 1212
o USA IR13.did 22/05/2023 12:04  iDAP image Storage: 5.8 MB
Satellite: GOES-16
- Format: HRIT image
Type: Infrared
Desktop
Data:  Channel 13 (10.30pm)
m
Libraries [ Preview:
This PC
Net;;\tork
< >
File name: USA IR13.did ~

Files of type: iDAP images (" did) ~ Cancel
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@ A new macro named USA IR13 will now have been added to the macro set.
In the Operations list, switch on Enhance. Ensure Use profile is selected
and Linear is selected in the drop-list below it. This will ensure the
animation frames have even contrast regardless of the time of day. The
window should now resemble figure 7.13.

Figure 7-1 3 Automatic processing settings 7 *
The Enhance operation | curertmasose:

|Defau\t vl (=

switched on and Macro settings
= | usa

CcO nﬁ g u red -[A[8] UsA R 13: Enhance Name: [ Automatic ~USA IR13: Enhance

Document: ‘C:\Darbcom\lmagESVJSA IR13.did Choose.... | Set file names

Operation settings
(®) Use profile:

Linear ~

Navigate (O Use preset:
Assign series
Blue Marble mask
DEM mask
Export image
Export data
Print

Save

Archive

Animate
Reproject
Palette product

<
o
b1
o
o
=3
I
3

[ o o [ [ i

Add macro... Add RGB product | | Add folder Duplicate | = Rename Delete...
Allon | | All off

Cut | | Copy | | Paste | | [Totop | | Up | Down | | Tobottom

Destination: | Above Firstin folder | Lastin folder Testmacro Cancel

@ In the Operations list, switch on Blue Marble mask. Ensure Slice and
Opacity are both set to 100% and Blending is set to Screen. In the Data set
drop-list, select Topography+Bathymetry 2004-08 (August) 1 minute.
The window should now resemble figure 7.14.

.
Flgure 7-1 4 Automatic processing settings 7 *
The Blue Marble mask | cuentmcos: .
. . | Defalt v| (=
operation switched on Matra setngs
=M1 | usa
and confi gu red 2 [8] USA R 3: Enhance, Blue Marble mask Name: [ Automatic | USA IR 13: Enhance, Blue Marble mask
Document: ‘Ci\Darbcom\lmagestSA IR13.did Choose.... | Set file names
Operation settings
¥ Operations Image processing
Enhance Sice: ¥ 100%
[ Filter
[ Navigate Opadity: ¥ 100%
[ Assign series -
Blue Marble mask Bendng
[ DEMmask
[0 Exportimage Gataer
[0 Exportdata Topography +Bathymetry 2004-08 {August) 1 minute ~
O erint Matrix size 10800 x 21600, top left at 130°W, 90°N
[0 save Longitude resolution 1.0, latitude resolution 1.0 (minutes of arc)
[ archive
[ animate
] reproject
[ Palette product
Add macro... Add RGB product | | Add folder Duplicate = Rename | Delete...
Allon | | All off

Cut | | Copy | | Paste | | [Totop | | Up | Down | | Tobottom

Destination: | Above Firstin folder | Lastin folder Testmacro Cancel
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O In the Operations list, switch on Save. Ensure Original file is selected. This
will cause the enhancement and Blue Marble mask to be saved. The window
should now resemble figure 7.15.

Figure 7.1 5 Automatic processing settings ? x
The Save Operation Current macro set:

. [ pefauit =1
switched on A
=] | usa

: & UsA IR13: Enhance, Blue Marble mask, Save

Name: [Z]Automatic | USA IR13: Enhance, Slue Marble mask, Save

Document: | C:\Dartcom\Images\JSA IR 13.did Choose.... || Set file names

Operation settings
Operations Save to:
Enhance (@) Original file
Filter O Copy:
Mavigate
Assign series
Blue Marble mask
DEM mask
Export image
Export data
Print

[ Archive

[] animate

[0 Reproject

[ Palette product

C:\Dartcom\Images\USA IR 13 copy.did Choose...

s o o Y

Addmacro... | | AddRGB product | | Add folder | | | Duplicate | | Rename | | Delete...
Allon | | Alloff

Cut Copy Paste To top Up Down To battom

Destination: | Above Firstin folder | Lastin foider Test macro Cancel

O In the Operations list, switch on Animate. Ensure all the options in the
Include area are switched on and Frequency is set to 10°. Set Sub-sample
level to 1:2 so the animation is half the size of the original image. Set
Maximum to 6 and select hours in the drop-list. The window should now
resemble figure 7.16.

.
Flgure 7.1 6 Automatic processing settings ? x
. . .
The Animate operation rﬁfat e
. Default - ]
switched on and Mac sttngs
= usa
Conﬁg u red [ [#] USA TR 13: Enhance, Blue Marble mask, Save, Animate (5 hours) Name: [~]Automatic | USA IR13: Enhance, Blue Marble mask, Save, Animate (24 frames)
Document: |C:\DE"'-CDW\IMEQESVJ5A R13.dd ‘ Choose.... | | Set file names
Operation settings
v Operations Indude
Enhance Map overlays Range rings
E Filter Station position Lat/lon legends
Mavigate
0O A::i'j:series Points features Frequency:
10° ~
Blue Marble mask Tk
[0 DEMmask —
[ Exportimage
O Exportdata Sub-sample level: B 1:2
Print —
Save Maximum: | & 2| hours  ~
[ Archive
Animation file name
[] Reproject ‘ C:\Dartcom\Images)USA IR 13.dmd Choose...

[ Palette product

Add macro... | | Add RGB product | Add folder Duplicate | | Rename | | Delete...
Allon | | All off

Cut Copy Paste To top Up Down To bottom

Destination: | Above Firstin folder | Lastin folder Test macro Cancel

@ Click [ to save the changes to the macro set.
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@ Click Test macro (below the Macro settings area). After the test,a message
will appear telling you if it was successful, and if not, what the problem was.

@ Click OK to close the Automatic processing settings window.

® Select File»Open.... The Open window (figure 7.17) is displayed. In the
Files of type drop-list, ensure All iDAP documents is selected. Select the
USA IR13 animation (# icon) and click Open.

Figure 7.17 Open %
The open W|nd0W Look in: | Images v| @ _3' ® '
with the USA IR13 o File details
. . MName Date modified Type - T
animation selected Date:  Thy, May 18, 2023
* Sample 22/05/202309:53  File folder 15'!mE= 1?l'=2~’é°=26°0f6m'c+1=°°}
H 1Ze: X
Quick access B0 UsA IR13.did 19/05/2023 1413 iDAP image Storage: 6.5 MB
## USA IR13.dmd 19/05/2023 1413 iDAP animation  Satelite: GOES-16
- Format: HRIT animation
Type: Infrased
Desktop
Data:  Channel 13 {10.30pm)
m
Libraries Preview:
This PC
MNetwork
£ >
File name: USA IR13.dmd w
Files of type: AlDAP documents (" did, * dmd) v Cancel

@ The USA IR13 animation is opened in a new iDAP animation window (figure
7.18). It will only have one frame at this point, but opening it allows you to
check the macro’s results and alter its settings if needed.

Figure 7.18 |[#%usarizoma 7 | ——
The USA IR13 animation

panl -

® Close the animation window, then move on to the next tutorial.

Tutorial 4: Reprojecting an image

This tutorial will show how to automatically reproject an image, which is normally done to
remove the perspective distortion inherent in a satellite view. Reprojecting an image in
iDAP and MacroPro involves warping it into a map option, which defines a cartographic
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projection (such as Mercator or Polar Stereographic), geographical area, physical image
size and overlay settings. The reprojected image is saved as a new iDAP image document.

@ Select Utilities»Automatic processing settings..., then select the USA IR13
macro. In the Operations list, switch on Reproject. The Automatic
processing settings window should now resemble figure 7.19.

.
Figure 7.19 | auomatic processing seiings r
.
The Reproject Current macra set:
. |Defau|t V‘ =]
operation Macro settings
N =-5| | usa . . 5 )
SW|tChed on .71 [8] USA TR 13: Enhance, Blue Marble mask, Save, Animate (6 hours), Reproject | Name: [ Automatic | USA IR 13: Enhance, Blue Marble mask, Save, Animate (24 frames), Reproject
Document: |C:\Darttnm\lmagesws»\ R13.did ‘ Choose... | | Set file names

Operation settings
Operations

Map option: v || Edit...
Enhance

Navigate

Assign series
Blue Marble mask

Slice: L} 0%

DEM mask [ Apply mask using colour: -
Export image
Export data [[JRecalculste enhancement
Frint (destroys any processing applied to the image)
Save Save reprojected image as:
Archive | C:\Dartcom\Images\USA TR 13 reprojected. did Choose. ..
Animate
Wil Reproject Addmacro | Archive | Exportimage = Animate | Palette product

OERONOOOOROO0OR <

Palette product

< >
Add macro... Add RGB product  Add folder Duplicate | | Rename Delete...
Allon | | Al off
cut | | Copy || Paste Totop | | Up
Destination: | Above First Test macro Cancel

® Next to the empty Map option drop-list, click Edit.... The Map options
manager window (figure 7.20) is displayed with one of the existing map
options selected.

Flgure 7.20 Map options manager ? X
The Map Options Map optian: | Africa Mercator 3km v| Ha Q& Mpeing
. Mode: (@) Easy
manager window O Cartoraphic (sdvancec)
Projection: Earth model:
Mercator ~ WGS 84 ~

Cylindrical - In equatorial aspect A | [ Automatically centre on station
all parallels are straight

horizontal, all meridians are Centre latitude: Centre longitude:
straight vertical and uniformly ‘ 1.0000 | o ‘ 16.0000 "
spaced.

Conformal -Locally preserved | =
angles, shape (area) may not be -130.0000 0.oooo
preserved, Most important for
navigational purposes.

Straight lines anywhereon | % T
projection are Loxodromes (=
Rhumb line, = constant bearing
path between two points).

Only possible conformal "
Image
Width: Height: Resolution:
(300 [x[3100  |pixess [3.0000  [km
Overlays... Appl

® In the Map option drop-list, select (new) to create a new map option. In the
Mapping area, ensure Mode is set to Easy, Projection is Mercator, Earth
model is WGS 84 and Automatically centre on station is switched off. For
Centre latitude enter 37 and for Centre longitude enter 82. Note that
latitudes south of the equator and longitudes east of 0° must be entered as
negative numbers.



USING THE SOFTWARE 7-13

O In the Image area, enter 1500 for Width and Height, and 2 for Resolution.

© Click Overlays... and add the GSHHG borders, L2 (Americas states) overlay
as described in step @ of tutorial 1.

O Click Apply to redraw the map option.

@ In the Map option drop-list, enter Eastern USA 2km, then click the [& icon.
The window should now resemble figure 7.21.

Figure 7.21 | wap cptions manager 7 x
The Map options | i cton: [essernusa zn IEs Q@ e
. Mode: Eas!
manager WIndOW . OCar:ographlc {advanced)
configured for e | ;

eastern USA

Cylindrical - In equatorial aspect A | ] Automatically centre on station
all parallels are straight

horizontal, all meridians are Centre latitude: Centre longitude:
straight vertical and uniformly | 37.0000 ‘ - | 32.0000 o
spaced.

Conformal - Locally preserved T T
angles, shape (area) may not be -3540.0000 0.0000
preserved. Most important for
navigational purposes,

Straight lnes anywhereon [ % T
projection are Loxodromes (=
Rhumb line, = constant bearing
path between two points).

Only possible conformal w
Image
Width: Height: Resolution:
1500 x | 1500 pixels 20000 |km
Overlays... Apply

Lat: 46.936°N, Lon: 067.979°W

@ Click Close to return to the Automatic processing settings window. Notice
that Map option has now been set to Eastern USA 2km.

O Next to the Save reprojected image as box, click Choose... and change the
name to Eastern USA IR13. The Automatic processing settings window
should now resemble figure 7.22.

.
Flgure 7.22 | suomac processing settings ? X
.
The Reproject Current macro set:
. |Defau\t vl (=]
operation configured Maca settings
= USA
- SA IR 13: Enhance, Blue Marble mask, Save, Animate (24 frames), Reproject
for eastern USA -[~] @] USA IR 13: Enhance, Blue Marble mask, Save, Animate (6 hours), Reproject { Mame: [/] Automatic | USA IR 13: Enhance, Blue Marble mask, Save, Anmate (24 frames), Reproject
Document: ‘C:\Darhtnm\lmagESUJSA TR 13.did | Choose...  Set file names
Operation settings
+  Operations
Map option: | Eastern USA 2km ~ | | Edit...
Enhance
[ Filter Base image: Choose... | | Clzar
[] Navigate
[] Assign series Slice: ] 0%
Blue Marble mask
0 oEMmask [] apply mask using colour: -
[0 Exportimage
[ Exportdata [JRecalaulate enhancement
O print (destroys any processing applied to the image)
Save Save reprojected image as:
O Archive ‘C:\Dart(um\lmagas\EastEm USA IR13.did “Chnnse..‘l
Animate
Leproj Add macro | Archive | Exportimage | Animate | Palette product
Reproject dd ch ! d
[ palette product
< >
Add macro... Add RGE product | | Add folder Duplicate | = Rename Delete...
Allon | | All off
Cut | | Copy | | Paste Totop | | Up T om
Destination: = Above First n folder Testmacro Cancel

O Click [ to save the changes to the macro set.
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Figure 7.23

The Eastern
USA IR13 image

M

@ If desired, click Test macro and open the reprojected image to check it

(figure 7.23) then return to the Automatic processing settings window as
shown in figure 7.22 and continue to the next tutorial.

Tutorial 5: Creating a palette product

This tutorial will show how to automatically create a palette product, which involves calcu-
lating a value for each pixel in an image and colouring the image using a palette that cor-
responds values to colours. The palette product is saved as a new iDAP image document.

For this tutorial, the palette product will be created from the reprojected image produced
by the USA IR13 macro configured in the previous tutorials.

Note that the Palette product operation for the USA IR13 macro will use the
original image, not the reprojected one. This is because the Reproject
operation produces a new iDAP image document. Therefore to create a
palette product from a reprojected image, it is necessary to add a new macro

©® Assuming you are in the Automatic processing settings window and it

resembles figure 7.22, in the Operation settings area notice the row of
buttons under the Save reprojected image as box. The Add macro button
creates a new macro for the reprojected image. The other buttons do the
same but also switch on the corresponding operation. So to add a macro
that creates a palette product for the Eastern USA IR13 reprojected image,
click the Palette product button.

® The Palette product settings for the new macro will have been displayed

automatically. In the Palette drop-list, select Land temperature (LST)
product. To ensure the correct formula is used, switch on Overrride and in
the Formula drop-list, select Temperature, GOES.

Next to the Save product as box, click Choose... and change the name to
Eastern USA LST product. The Automatic processing settings window
should now resemble figure 7.24.
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Figure 7.24 Automatic processing settings 7 *
The Palette product pretreses: s
. efaul ~ ]
operation configured = Macrosetigs
=
for Ia n d te m peratu re @ USA IR 13: Enhance, Blue Marble mask, Save, Animate (5 hours), Reproject { Name: Automatic = Eastern USA IR 13: Palette product (Land temperature (LST) product - Temper
@ Eastern USA IR13: Palette product (Land temperature (LST) product - Tempe S ‘ i \Dartcom\images Eastem USA TR 13.did ||Choose..‘ ‘ ‘ e e— ‘
Onerat Operation settings
v Operations Palette:
E :::noe ‘Land temperature (LST) product ~ |
ilter
E :a“‘ga‘f Formula: [ Override
ssign series
[ Blue Marble mask Temperature, GOES “|
[0 DEMmask result=calib(10.3)
[] Exportimage
[] Exportdata
] Print
[ save
] Archive
[0 animate
[0 Reproject
Palette product
Save product as:
< > ‘ C:\Dartcom\Images\Eastern USA LST product.did “Choose.“ |
[ Add macro... | | AddRe8 procuct | | Add folder | | | Duplicate | | Rename | | elete. . | | Addmacro | | archive | | Exportimage | | Animate | | Reproject |
All off
Paste ‘ Down | Tobottom
Destination Festin ader | Lastinfaldr o]

O Click € to save the changes to the macro set.

© If desired, click Test macro and open the palette product to check it (figure
7.25), then return to the Automatic processing settings window as shown
in figure 7.24 and continue to the next tutorial.

Figure 7.25

The Eastern USA LST
product image

Tutorial 6: Masking a palette product

This tutorial will show how to automatically apply a mask to a palette product. This is
normally done to obscure irrelevant areas, such as sea in a land temperature product.

© Assuming you are in the Automatic processing settings window and it
resembles figure 7.24, in the Operation settings area notice the row of
buttons under the Save product as box. To add a macro for the Eastern
USA LST product image, click the Add macro button.
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Figure 7.26

The DEM mask
operation switched
on and configured

Figure 7.27

® The new macro will have been displayed automatically. In the Operations
list, switch on DEM mask.

© In the Operation settings area, switch off Land mask, switch on Sea mask
and ensure Solid is selected.

O In the Image processing area, set Blending to Normal.

O In the Data set area, select ETOPO1 global 1 minute. The window should
now resemble figure 7.26.

Automatic processing settings ? X
Current macro set:
| Default “ ‘ (=
Macro settings
=] USA
|71 8] USA R 13: Enhance, Blue Marble mask, Save, Animate (6 hours), Reproject (| Name: ElAutomatic | Eastern USA LST: DEM mask
H @ Eastern USA IR 13: Palette product {Land temperature {LST) product - Tempe|
D t: | C:\Dartcom\Images\Fastern USA LST product.did Choose.... | | Set fil
..}71 8] Eastern USA LST product: DEM mask ocumen | ‘ [Ghoose... || Set fie names
Operation settings
¥ | Gperations [Jtand mask Sea mask
O Enhance Soid @ solic
O Fer Graduated by height: O Graduated by depth:
[ navigate Colour 1 highest Calour 1 deepest

[ Assign series
[] Blue Marble mask

Colour 2 highest
Graduated atlas colours

Calour 2 deepest
() Graduated atias colours

DEM mask Colour 11 Colour 2 Colour 1 Color 2
Export image -
[ Exportdata - - -
E :;:; Image processing
O rchive Slice: ¥ 100%
O Animate Cpadity: ¥ 100%
[ Reproject
[ Palette product Blending:
Data set
|ETOPO1 global L minute v

Matrix size 21601 x 10801, top left at 180%W, 90°M
Longitude resolution 1.0, latitude resolution 1.0 {minutes of arc)

< >

[Addmago... | | AddRGBproduct | Add folder | | | Dupiicate | [ Reneme | | Dekte... | T
[airon | [aloff |
| T

Destination: Firstin folder | Lastin folder

Cemal [[Coc ]

O In the Operations list, switch on Save. Ensure Original file is selected. This
will cause the DEM mask to be saved.

@ Click | to save the changes to the macro set.

O |If desired, click Test macro and open the masked palette product to check it
(figure 7.27).

B ot U5 T producdid Y - |

=i =ra

The Eastern USA LST
product image with
DEM mask applied




Figure 7.28

The ACHT FD
product selected

USING THE SOFTWARE 7-17

Tutorial 7: Restoring colour to a GOES HRIT product

The GOES HRIT service includes a number of level 2+ products that are transmitted as

greys

cale images, although they would originally have had a colour palette. This tutorial

will show you how to set up an output for a GOES HRIT product in XRIT Ingester, then
create a palette product from it automatically in MacroPro to restore the original colours
and provide a colour scale key.

O Ifitis not already running, start XRIT Ingester from the Windows Start menu.
@ Click the GOES HRIT tab, then click the Output tab.
©® Right-click the USA IR13 output added in tutorial 1 and select Duplicate

output....

O Change Name to USA ACHT.
O In the Product drop-list select ACHT FD. A preview is displayed on the right-

hand side. The window should now resemble figure 7.28.

iDAP image output settings ? X

Name:

Service: | GOES-16 ~| Data type: | GOES-16 product
Planes Area
(@) single plane (greyscale) ) Whole image
(O Multi-plane (false colour) (@) Selected area:
Master Product Left: Top:

O [k

Sub-sample by factor

' 110
11 1:32
EEEN -
Enhancement: (O Default
Min-max ~|  @custom | Edit..

Save
Path:

File name: (") Build automatically:

| USA ACHT

Width: Height:

(®) Use default: C:\Dartcom\Images
O C:\Dartcom\Images Choaose...

Channel Data type Date and time
Service Products
(®) Use output name

O
[ Archive .
O e U i B [“IFit preview to view  [] Show overlay

Delete fles over | 3 —

O Click OK.

@ Click Apply settings (below the Output tab).

O In the Latest data list within the Output area in the Status area, select
GOES-16/18»Image data»GOES-16/18 product>ACHT FD as appropriate.
Its preview will be displayed on the right-hand side. Wait until a new version
of the product has been received and the new output has run, then continue
to the next step.

© Assuming Macro Pro is already running and its window is visible, select
Utilities»Automatic processing settings.... The Automatic processing
settings window is displayed, resembling figure 7.26.

@ Right-click the USA folder and select Add macrorLast in folder.... The

Image to process window (figure 7.12) is displayed. Choose the USA ACHT
image.
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® A new macro named USA ACHT will now have been added to the macro set.
In the Operations list, switch on Palette product.

@ In the Palette drop-list select GOES HRIT ACHT. The window should now
resemble that shown in figure 7.29.

Figure 7.29 | suomstc processing sttings r

The Palette product flresnoose: Hs
. i CEs
operation switched on

Macro settings

USA
an d co nﬁ g u red fo r AC HT [8) USA R13: Enhance, Blue Marble mask, Save, Animate (6 hours), Reproject (| 'Vame: [l Automatic | USA ACHT: Palettz praduct
8] Eastern USA IR 13: Palette product (Land temperature (LST) product - Tempe -
o! t: | C:\Dartcom\Images\USA ACHT.did Chu ... | Set fil
@] Eastern USA LST product: DEM mask, Save ocumen | 00se. . | [Set e names
..[ [6] USA ACHT: Palette product (GOES HRIT ACHT) Operation settings
+  Operations Palette:
L] Enhance GOES HRIT ACHT v
[ Fitter
i Edit...
[ Navigate Formula: []Override !
[ Assign series =
D Blue Marble mask GOES HRIT Cloud Top Temperatures
[J DEMmask result=calib(arey)
[ Exportimage
[ Exportdata
O Frint
[ save
[ Archive
[ Aanimate
[0 Reproject
Save product as:
< > | C:\Dartcom\Images\WSA ACHT product.did Choose...
Add macro... Add RGB product | | Add folder Duplicate Rename Delete... Al al off Add macro Archive Export image Animate Reproject
on o
Cut Copy Paste To top Up Down T ttom
Destination: | Above Firstin folder || Lastin folder Test mecro Cancel

@ Note the name that has been automatically set for the resulting palette
product (USA ACHT product) in the Save product as box.

® Click | to save the changes to the macro set.

@ If desired, click Test macro and open the palette product to check it (figure
7.30).

Figure 7.30 [fzorr= --m

[, R Gt i polte) Ty, Wy B, 073 71672 (TG00 oot
The USA ACHT product
image window

When the image is opened in iDAP, you can display a key (or legend) for the palette
colours by selecting View»Key... (figure 7.31). This facility is not available in MacroPro.



Figure 7.31

The iDAP Key window
for the USA ACHT

Tips

product image

Key
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GOES HRIT Cloud
Top Temperatures

f=

K

180.000
183.294
186.588
189.882
193.17%
196,471
199,765
203,052
206,353
209.647
212,941
216.235
2159.529
222.824
226,118
2258.412
232.706
236,000
239,294
242,588
245,832
249,176
252.471
255.765
255.059
262,353
265.647
268.941
272,235
275.529
273.824
282,118
285.412
288.706
292.000
295.294

Below are a number of useful tips, tricks and shortcuts which make many tasks in the
software quicker and easier.

XRIT Ingester

To make XRIT Ingester start up automatically when you switch on the host PC
or after a power failure, add its shortcut icon to the Windows Startup folder.
To display that folder, right-click the Windows Start button, select Run, then
enter shell:startup and click OK.

The Duplicate... button in the Output tab is very useful for quickly creating
a number of similar outputs. For example, to create several outputs covering
the same area with different products, add the first output, then repeatedly
use the Duplicate... button, simply changing the name and products as
appropriate. All the other settings will be copied from the previous macro.

When creating a multi-plane iDAP image output, good false colour images
can be obtained during daylight hours by assigning a visible product to the
red and green planes and an infra-red product to the blue plane.

To create images of a specific size (for use on a website, for example), use the
to size sub-sampling method when adding an iDAP image output, then use
a MacroPro macro to export the resulting images to JPEG or PNG format via
the Export image operation.
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Remember to click Apply settings after adjusting settings otherwise they
will not take effect.

To prevent changes being made to the settings or the software being closed
without authorisation, lock the software using the Lock... button. Make sure
the password you choose is well known to you or written down and stored
somewhere safe, otherwise you will not be able to unlock the software again.

MacroPro

The DEM mask and Blue Marble mask automatic processing operations
work more consistently with infra-red or water vapour images when slicing
out cloud, or if using the Screen blending mode. This is because on visible
images the pixel values corresponding to cloud vary according to the time of
day. Itis therefore not possible to set a slice level which works for all images,
or obtain a consistent blending level.

Make sure that you click OK when you have finished setting up macros in the
Automatic processing settings window otherwise none of your macros will
run. This is because automatic processing is suspended temporarily while
the Automatic processing settings window is open.

MacroPro is not intended for viewing images and animations (unless you are
checking the results of a macro). Use iDAP instead because it provides the
full range of manipulation and processing facilities whereas MacroPro only
provides a very limited subset.

If you make changes to the iDAP configuration and want to quickly apply the
same changes to MacroPro, simply click the Synchronise with iDAP button
in the MacroPro Configuration window (Utilities»Configuration...).

To prevent changes being made to the macros or the software being closed
without authorisation, lock the software using Utilities»Lock.... Make sure
the password you choose is well known to you or written down and stored
somewhere safe, otherwise you will not be able to unlock the software again.

iDAP

To make iDAP start up automatically when you switch on the host PC or after
a power failure, add its shortcut icon to the Windows Startup folder. To
display that folder, right-click the Windows Start button, select Run, then
enter shell:startup and click OK.

The DEM masking (Navigation»DEM mask...) and Blue Marble masking
(Navigation»Blue Marble mask...) functions work more consistently with
infra-red or water vapour images when slicing out cloud, or if using the
Screen blending mode. This is because on visible images the pixel values
corresponding to cloud vary according to the time of day. It is therefore not
possible to set a slice level which works for all images, or obtain a consistent
blending level.

A number of additional tools are available for animations by clicking the ¥
button in the bottom right corner of the window. These include playback
speed and looping, selection of the part of the animation to play, quick
zooming and removal of unwanted frames.

If you make changes to the iDAP configuration and want to quickly apply the
same changes to MacroPro, simply click the Synchronise with iDAP button
in the MacroPro Configuration window (Utilities»Configuration...).
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« To prevent changes being made to the macros or the software being closed
without authorisation, lock the software using UtilitiesrLock.... Make sure
the password you choose is well known to you or written down and stored
somewhere safe, otherwise you will not be able to unlock the software again.

You should now be familiar with the core functionality of the software and ready to begin
exploring it in detail using the knowledge gained from the tutorials and tips as a basis.

Please refer to the separate XRIT Ingester software user guide and iDAP/MacroPro software
user guide for further information.






